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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Vitelity and Avaya IP Office 9.1 Server Edition.

Vitelity SIP Trunk Service (Vitelity) provides PSTN access via a SIP trunk between the
enterprise and the Vitelity network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between Vitelity and Avaya IP Office Server Edition solution. In the sample configuration,
the Avaya IP Office Server Edition solution consists of the Primary Server running the Avaya

IP Office Server Edition Linux software Release 9.1, Avaya IP Office Server Edition Expansion
System (500V2), and Avaya Communicator for Windows (SIP mode), Avaya H.323, Avaya SIP,
digital and analog endpoints.

Vitelity referenced within these Application Notes is designed for business customers. The service
enables local and long distance PSTN calling via standards-based SIP trunks as an alternative to
legacy analog or digital trunks, without the need for additional TDM enterprise gateways and the
associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office Server
Edition and connecting to Vitelity.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office Server Edition and the
Vitelity network should be transparent to SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office Server Edition was connected to Vitelity. To verify
SIP trunking interoperability, following features and functionality were exercised during the
interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All inbound PSTN calls were routed to
the enterprise across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP
mode).

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international call, inbound toll-free,
outbound toll-free, 411 Directory Assistant and 911 services.
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Codec G.729A and G.711MU.

Caller number/ID presentation.

Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 pass-through.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Item not supported include the following:

SIP REFER in Call Transfer (transferring calls with the PSTN back to the PSTN).

SIP OPTIONS sent by Vitelity.

Outbound calls to Operator Assisted Call.

Faxing using T.38.

The setting of G.729A as the first priority codec on Vitelity system. (Vitelity always uses
codec G.711MU as the first priority codec).

2.2. Test Results

Interoperability testing of Vitelity was completed with successful results for all test cases with the
exception of following limitations:

Blind Call Transfer to PSTN using Avaya 1140E SIP phone did not complete until
transferee picked up the call - PSTN phone called to Avaya 1140E SIP phone, then Avaya
1140E SIP phone answered the call and performed blind transfer to another PSTN endpoint.
The expected behavior of Avaya 1140E SIP phone is after the transfer is completed, the
phone should display “transfer completed”. But in this case, after user pressed “transfer”
button and answered question of “Consultative transfer with party ?”” with “No”, which
implied the blind transfer, the transferee PSTN phone rang and the Avaya 1140E SIP phone
was still displayed “transferring” until the transferee PSTN phone answered the call. The
work around was to hang up the Avaya 1140E SIP phone. This is a known limitation on
Avaya 1140E SIP phone. There is no user impact. Transfer is still completed with two-way
audio.

The call was dropped between PSTN phones if the Avaya IP phone disconnected the
conference — Call scenario was when Avaya IP phone hosted the conference among PSTN
phones. Then, the Avaya IP phone disconnected the conference. The call was dropped
between PSTN phones. The issue is under investigation.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com
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For technical support on the Vitelity, please contact customer service at 1-888-898-4835 or visit:
http://www.vitelity.com/

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Vitelity through the public IP network. For confidentiality and privacy purposes, actual
public IP addresses used in this testing have been masked out and replaced with fictitious IP
addresses throughout the document.

The Avaya components used to create the simulated customer site including:
IP Office Server Edition Primary Server

IP Office Server Edition Expansion System (500V2)

Avaya 9600 Series IP Deskphones (H.323)

Avaya 11x0 Series IP Deskphones (SIP)

Avaya 1408 Digital phones

Avaya Analog phones

Avaya Communicator for Windows (SIP)

The Primary Server consists of a HP ProLiant DL360 server, running the Avaya IP Office Server
Edition Linux software Release 9.1. The server is the only mandatory component required to support
SIP trunking and IP endpoints. Avaya Voicemail Pro runs as a service on the Primary Server. The
LANL1 port of the Primary Server (Eth0) is connected to the enterprise LAN. The LAN2 port (Ethl)
was not used during the compliance test.

The optional Expansion System (500V2) is used for the support of digital, analog and additional IP
stations. It consists of an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion module
which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8 card
which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM (Voice
Compression Module) for supporting VolIP codecs. The LAN1 port of the Avaya IP Office IP500V2
is connected to the enterprise LAN. The LAN2 port was not used.

A separate Windows 7 Enterprise PC runs Avaya IP Office Server Edition Manager to configure and
administer Avaya IP Office system.

Mobility Twinning is configured for some of the Avaya IP Office Server Edition users so that calls
to these user’s phones will also ring and can be answered at configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office Server Edition with Vitelity SIP Trunk
Service

Inbound calls from the service provider via SIP trunk arrive to Server Edition Primary Server, where
Incoming Call Routes are checked to determine the call destination. In the event that the destination
of the incoming call is an endpoint in the Expansion System (500V2), the call is sent via the Small

Community Network (SCN) H.323 trunk to the expansion IP500V2 for routing to the final endpoint.
This SCN H.323 trunk is automatically created during the initial process of addition of the
Expansion System to the IP Office Server Edition solution.

Similarly, outbound calls from the enterprise to the PSTN are routed via the SIP trunk to the Vitelity
network. Calls originated from extensions registered to the Primary Server are routed directly to
Vitelity, while calls originated from extensions on the Expansion System are sent to the Primary
Server via SCN H.323 trunk, before being routed to Vitelity via the SIP trunk.

For the purposes of the compliance test, Avaya IP Office Server Edition users dialed a short code of
6 + N digits to send digits across the SIP trunk to Vitelity. The short code of 6 was stripped off by
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Avaya IP Office Server Edition but the remaining N digits were sent unaltered to Vitelity. For calls
within the North American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus,
for these NANP calls, Avaya IP Office Server Edition would send 11 digits in the Request URI and
the To header of an outbound SIP INVITE request. It was configured to send 10 digits in the From
field. For inbound calls, Vitelity sent 10 digits in the Request URI and the To header of an inbound
SIP INVITE request.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and Avaya IP Office Server Edition, such as, a session
border controller or a data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes. However, it should be noted that SIP and RTP traffic
between the service provider and Avaya IP Office Server Edition must be allowed to pass through
these devices.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components
Equipment Release
Avaya IP Office Server Edition solution 9.1.100.10
e Primary Server HP ProLiant DL360 G7 — 9.1.100.10
IPO-Linux-PC
e Voicemail Pro 9.1.100.3
e Expansion System (V2) — IP 500 V2 9.1.100.10
e Avaya IP Office Analogue PHONE 8 9.1.100.10
e Avaya IP Office VCM64/PRID U 9.1.100.10
e Avaya IP Office DIG DCPx16 V2 9.1.100.10
Avaya IP Office Server Edition Manager 9.1.100.10
Avaya 1140E SIP 04.04.18.00
Avaya IP 9640G S3.2
Avaya IP 9630 S3.2
Avaya Communicator for Windows (SIP) 2.0.3.30
Avaya Digital Telephone (1408D) R40
Avaya Symphony 2000 Analog Telephone N/A
HP Officejet 4500 (fax) N/A
Vitelity Components
Equipment Release
OpenSIPS 1.11.4

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without
T.38 Fax Service.
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5. Configure Avaya IP Office Server Edition Solution

This section describes the Avaya IP Office Server Edition solution configuration necessary to
support connectivity to the Vitelity SIP Trunk Service. It is assumed that the initial installation and
provisioning of the Server Edition Primary Server and Expansion System has been previously
completed and therefore is not covered in these Application Notes. For information on these
installation tasks refer to [3] in the Additional References section 9.

This section describes the Avaya IP Office Server Edition configuration to support connectivity to
Vitelity. Avaya IP Office Server Edition is configured through the Avaya IP Office Server Edition
Manager PC application. From a PC running the Avaya IP Office Server Edition Manager
application, select Start - Programs - IP Office > Manager to launch the application. Navigate
to File > Open Configuration, select the proper Avaya IP Office Server Edition system from the
pop-up window, making sure the box for Open with Server Edition Manager is checked. Log in
using appropriate credentials.

Y™ Avayn P Ofice Manoger
e It Yew Tochh Hep
-t

=

¢ Open weth Server Edtion Mensger
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The appearance of the IP Office Server Edition Manager can be customized using the View menu. In
the screens presented in this section, it includes the system inventory of the servers and links for
administration and configuration tasks.

W™ Bvayn 7 Office Manoger for Server Edition DevCon IPO Sev2 [ 100.10] fadwinistratoriAdministrotad) = S
e I Yew Toch Hep
) d 0z 48 v H

Summary Open

Address Primary Lnk  Users Configored Extenrmoms Configured

Schition 5 5
& Pomary Satver DeCon PO Se2 10109742 - 4
& Expension System DevCoonfPO_EX42 10103740  Bothway 1 1
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5.1. Licensing

The configuration and features described in these Application Notes require the IP Office Server
Edition system to be licensed appropriately. If a desired feature is not enabled or there is
insufficient capacity, contact an authorized Avaya sales representative.

Licenses for an IP Office Server Edition solution are based on a combination of centralized licensing
done through the IP Office Server Edition Primary Server, and server specific licenses that are
entered into the configuration of the system requiring the feature. SIP Trunk Channels are
centralized licenses, and they are entered into the configuration of the Primary Server. Note that
when centralized licenses are used to enable features on other systems, such as SIP trunk channels,
the Primary Server allocates those licenses to the other systems only after it has met its own license
needs. To verify that there is a SIP Trunk Channels license with sufficient capacity, select License
under Primary on the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that
there is a valid license with sufficient “Instances” (trunk channels) in the Details pane. Note that the
actual License Key in the screen below was edited for security purposes.

'™ Avayn 7 Office Manager for Server Edticn DevCon IPO Sev 191 100,10 A
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5.2. System Tab

Navigate to System (1) under the DevCon IPO Sev2 on the left pane and select the System tab in
the Details pane. The Name field can be used to enter a descriptive name for the system. In the
reference configuration, DevCon IPO Sev2 was used as the name in the Primary Server. Make sure
to check the Enable Softphone HTTP Provisioning box to enable the support of Avaya IP Office
Softphone.

| [
Configuration | System || & DevCon IPO Sev2* v
R poomw Marre — : :
el LANL LMD (DNS | Vescemwd | Tebmpheny | Dinectory Servces | byssem bynnts | SMIP | AMDR | Taanneng | Coders | Yol Securiy - Commap 1
peratn % DevCan PO Sesd - . - -
Nae DesCom B0 Seald Lecde Ursted States (L5 Enghaty -
L it <Nanes .
Contact brioomation
Thee System it under Integraced Management contror
Serve: Edtioe Schution
Device it
TFIP Server P Addrens 9 ’ 0 0
HTT? Serves IP Addres ]
Ok - WITR Rechrectinn | O .
e B
q 0

) : 0

8051 e D2 THNGHS] 0c a1 05T 0

1 ] 0
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5.3. LAN1 Settings

In the sample configuration, LANL1 is used to connect both the Primary Server and the Expansion
System to the enterprise network. The DevCon IPO Sev2 was used as the Primary Server name and
DevConnlPO_EX42 was used as the Expansion System name.

To configure the LANL1 settings on the Primary Server, complete the following steps. Navigate to
DevCon IPO Sev2 - System (1) in the Navigation and Group Panes and then navigate to the
LAN1 - LAN Settings tab in the Details Pane. Set the IP Address field to the IP address assigned
to the Avaya IP Office Server Edition LAN1 port. Set the IP Mask field to the mask used on the
public network. All other parameters should be set according to customer requirements. Click OK to
submit the change.

Configuration ;le:;' DevCon IPO Sev2* v

w1 | Tebphony | Diactory Servces | ysoem fysnts | SMEP | SMDE | Toaanaung | Coders | Vol Securry - Conmar

srt & Diabéed Avanced

-

i

& Gow D
8% St Coze

The VolIP tab as shown in the screenshot below was configured with following settings.

e Check the H323 Gatekeeper Enable to allow Avaya IP Deskphones/Softphones using the
H.323 protocol to register.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Vitelity.

e Check the SIP Registrar Enable to allow Avaya IP Deskphones/Softphones to register using
the SIP protocol.

e Input Domain Name as 10.10.97.42.

e The Layer 4 Protocol use UDP with UDP Port as 5060, and TCP with TCP Port as 5060.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

o Verify the DiffServ Settings were kept as default for the Differentiated Services Code Point
(DSCP) parameters in the IP packet headers to support Quality of Services policies for both
signaling and media, the DSCP field is the value used for media and the SIG DSCP is the
value used for signaling.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN Server will not be used.

e Set the Binding Refresh Time (seconds) to 30. This value is used as one input to determine
the frequency at which Avaya IP Office Server Edition will send SIP OPTIONS messages to
the service provider.

e Set Public IP Address to the IP address of the Avaya IP Office Server Edition LAN1 port.

e Set Public Port for UDP as 5060.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

7 DevCon IPO Sev2* ef - ¥ v

‘E)ls&im\ { LAN2 l DNS | Voicemail | Telephony I Directory Services l System Events l SMTP I SMDR l Twinning l Codecs ] VolIP Security l Contad it e

Network Topology Discovery

STUN Server Address STUN Port 3478

Firewall/NAT Type Open Internet v ]

Binding Refresh Time (seconds) 30 =

Public IP Address 10 10 97 42 ‘ Run STUN Cancel

Public Port
upp 5060

TCP 0

TLS 0

[T] Run STUN on startup

[ OK H Cancel J‘ Help
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To configure the LANL1 settings tab for the Expansion System, navigate to DevConnlPO_EX42 -
System (1) in the Navigation and Group Panes and then navigate to the LAN1 - LAN Settings tab
in the Details Pane. The IP Address and IP Mask fields should be populated with the values assigned
during the Expansion System initial installation process. Verify the configuration or modify the
values if needed. While DHCP was disabled during the compliance test, this parameter should be set
according to customer requirements. Other settings were left at their default values. Click OK to
submit the change.

=
System | 3 DevConniPO_EX42" v
System |LANL AN NS Yosczmmunl | Telesbony | Droctory Serwces | System Exants | SMTP | SIMDR |~ Tawrvmg | VEM | Cosexs | Vel Securfty

LAN Settirge P Netwizk Tepsizgs

The VolIP tab for LAN1 in the Expansion System can be configured using the same values
previously described for the VolP tab in the Primary Server. The parameters in Network Topology
tab can be left in the default settings for the Expansion System.
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5.4. System Telephony Settings

Navigate to DevCon IPO Sev2 - System (1) in the Navigation and Group Panes (not shown) and
then navigate to the Telephony - Telephony tab in the Details Pane. Choose the Companding
Law typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit
Off-Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
service provider across the SIP trunk. Set Hold Timeout (secs) to 1200.

The Maximum SIP Sessions field appears only in Server Edition systems. On Server Edition
systems, the Maximum SIP Sessions value must match the total number of SIP set and trunks calls
that can occur at the same time. The Maximum SIP Sessions setting determines the number of SIP
Trunk Channel licenses reserved for concurrent sessions on any SIP trunks provided by the server.
Those licenses are reserved from the pool of SIP Trunk Channel licenses in the configuration of the
Primary Server shown on Section 5.1. In the compliance test, 512 sessions were reserved on the
Primary Server. Defaults were used for all other settings. Click OK to submit the changes.

= DevCon IPO Sev2 e - v

[ system [ Lant [ Lane [N [ Veicemail| Teephory] | Direcory Semvice | ystem Events [ SMTP. [ SMDR [ Twinning [ Codecs [ volp secury | Contaci ¢ -

[Tefephony] | Park & Page | Tones & Music| Ring Tones [ sM [ alllog [Tu1 |

Dial Delay Time (secs) 4 :

Dial Delay Count 0 2 Swnch Hine

Default No Answer Time (secs) 15 =

Hold Timeout (secs) 1200 =

Park Timeout (secs) 300 = Rekaw 8 Actawlbine

Ring Delay (secs) 5 2 —

Call Priority Promotion Time (secs) Disabled < e

Default Currency [USD v} e

Maximum SIP Sessions 512 N ’ @ ShowvAccount s

o B [Favour Frunk o ‘ [T] Inhibit Off-Switch Forward/Transfer

Media Connection Preservation \Enabled vJ I Rectick Natwok ntsrcaanact

Phone Failback {Automatic Z I Include location specific information
Login Code Complexity

- [¥] Drop External Only Impromptu Conference
V| Enforcement
- = Visually Differentiate External Call
Minimum length 4 v
[7] Complexity High Quality Conferencing

[¥] Directory Overrides Barring

| OK J| Cancel H Help ].

Navigate to DevConnlPO_EX42 - System (1) and repeat the steps above to configure the
Telephony settings for the Expansion System. Since the SIP trunk will be terminated on the Primary
Server, it was not necessary to enter a value in the Maximum SIP Sessions field in this case, and the
default value of 0 was used (not shown).
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5.5. System Codec Settings

Navigate to DevCon IPO Sev2 - System (1) in the Navigation and Group Panes (not shown) and
then navigate to the Codecs tab in the Details Pane. Choose the RFC2833 Default Payload as IP
Office Server Edition default of 101. Select codecs G.729(a) 8K CS-ACELP, and G.711 ULAW
64K that Vitelity supports. Click OK to submit the changes.

7 DevCon IPO Sev2* B - X | v
| System | LANL | LAN2 | DNS | Voicemail I Telephony I Directory Services l System Events ] SMTP l SMDR l Twinning‘ Codecs iVoIP Security | Contacl ¢ | *
‘ RFC2833 Default Payload 101 =
Available Codecs Default Codec Selection
Unused Selected
G.711 ALAW 64K > G.729(a) 8K CS-ACELP '
G.722 64K G.711 ULAW 64K
[V G.729(a) 8K CS-ACELP
[ OK ] [ Cancel ] { Help
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5.6. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller 1D parameter on the SIP Line form (shown in Section 5.7.2).

If Send original calling party information for Mobile Twinning on the Twinning tab is checked,
the setting of the second parameter is ignored and Avaya IP Office Server Edition will send the
following in the SIP From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office Server Edition will
send the calling party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office Server Edition will send the
calling party number of the host phone associated with the twinned destination (instead of the
number of the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the DevConn IPO Sev2 - System (1) = Twinning tab was unchecked. The value
sent in the SIP From header is determined by the setting of the Send Caller ID parameter on
the SIP Line form.

= DevCon IPO Sev2* | v

| system | LANL [ LAN2 [ DNS | Voicemail | Telephony | Directory Services | System Events [ sMTP | sMDR | [Twinning| |veM | Codecs | VoIP Security | Contact Center|

| | Send original calling party information for Mobile Twinning |

| Calling party information for
Mobile Twinning
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5.7. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office Server Edition and
Vitelity SIP Trunk service. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used by IP
Office Server Edition Manager to create a SIP Line. Follow the steps in Section 5.7.1 to create the
SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.7.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.
e SIP Advanced Engineering.

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane
and select New - SIP Line. Then, follow the steps outlined in Section 5.7.2.

For the compliance test, SIP Line 17 was used as trunks for outgoing calls and SIP Line 18 was used
as trunks for incoming calls.
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5.7.1. Create SIP Line from Template.

1. Copy the template files to the computer where IP Office Server Edition Manager is installed.
Rename the template files to AF_Vitelity 17 SIPTrunk.xml (for SIP Line 17) and
AF_Vitelity_18 SIPTrunk.xml (for SIP Line 18). The file names are important in locating
the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Server Edition Manager. In IP Office
Server Edition Manager, navigate to File = Preferences. In the IP Office Server Edition
Manager Preferences window that appears, select the Visual Preferences tab. Verify that the
box is checked next to Enable Template Options. Click OK to submit the changes.

= |
™ IP Office Manager Preferences lw
| Preferencesj Directories ] Discoverﬂ [Visual Preferences Security I Validationv‘
| Icon Size [Small vl
[7] Multiline Tabs
[ [¥] Enable Template 0pti0ns|
[¥] Enable Template Creation
(i) ‘ oK l [ Cancel l l Help

3. Import the template into IP Office Server Edition Manager. From IP Office Server Edition
Manager, select Tools = Import Templates in Manager. This action will copy the template
file into the IP Office template directory and make the template available in the IP Office
Server Edition Manager pull-down menus in Step 5.
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In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window
below will appear stating success (or failure). Then click OK to continue. If preferred, this
step may be skipped if the template file is copied directly to the IP Office template directory.

Template Provisioning

=]

|' . 'i Successfully imported templates to IP Office Manager from
QY C\Vitelity\Template

T ox |

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then

navigate to New SIP Trunk from Template.
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“ P Offee Line
Houm b 1 Tebag hone N b
ramport Type Wekiocket Server i
Pletmtrhing Leved SN £y p 000
e Unnei wred {umbar of Chamned %
oy rtnels %
Pww b ey

T8 ) [Fow 00 Trink feurm Tarrglon | T v
o i. $ Cw b ot Clous $ON Uacisg Optzons
§ yss Copy v | Sugpeds Felbuach
ga basiwerd sesesserernies
™9 | Facky up my F Fhones
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5. In the subsequent Template Type Selection pop-up window, check Display All and select
AF_Vitelity 17 SIPTrunk from the Service Provider pull-down menu as shown below.
These values correspond to parts of the file name (AF_Vitelity_17_ SIPTrunk.xml) created
in Step 1. Click Create new SIP Trunk to finish creating the SIP trunk.

™ Template Type Selection | LEJ,
Locale United States (S English)

Service Provider | AF_Vitelity_17_SIP Trunk

= |i (V] Display Al

Create new SIP Trunk ]

Cancel |
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Select AF_Vitelity 18 SIPTrunk from the Service Provider pull-down menu as shown
below. These values correspond to parts of the file name (AF_Vitelity 18 SIPTrunk.xml)
created in Step 1. Click Create new SIP Trunk to finish creating the SIP trunk.

™ Template Type Selection ll]&]

Locale United States (US Engilish)
Service Provider 1AF_VdeIity_18_SIPTmnk v] (V| Display Al
[Create new SIP Trunk J [ Cancel ]

6. Once the SIP Lines are created, verify the configuration of the SIP Lines with the
configuration shown in Section 5.7.2 and 5.7.3.
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5.7.2. Create SIP Line Manually for Outgoing Calls

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line (not shown).
On the SIP Line tab in the Details Pane, configure the parameters as shown below:

e Set ITSP Domain Name to the IP address of Avaya IP Office Server Edition LAN1 port.
This field is used to specify the default host part of the SIP URI in the From, To, R-URI
fields for outgoing calls. For the user making the call, the user part of the From SIP URI is
determined by the settings of the SIP URI channel record being used to route the call (see
SIP URI - Local URI). For the destination of the call, the user part of the To and R-URI
fields are determined by dial short codes of the form 6N;/N”@192.168.142.93” where N is
the user part of the SIP URI and “@192.168.142.93” is optional and can be used to override
the host part of the To and R-URI.

Check the In Service and Check OOS boxes.

Set URI Type to SIP.

For Session Timers, set Refresh Method to Reinvite with Timer (seconds) to 1200.

For Forwarding and Twinning, set Send Caller ID to Diversion Header.

For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never. Note: Vitelity did not support the REFER for compliance testing.
Default values may be used for all other parameters.

e Click OK to commit then press Ctrl + S to save.
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of Vitelity signaling server
192.168.142.93 as shown in Figure 1. This is the SIP Proxy address used for outgoing SIP

calls.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send

Port was set to 5060 which is the port number supported by Vitelity.

e The Use Network Topology Info parameter was set to LAN 1. This associates the SIP Line 17
with the parameters in the DevCon IPO Sev2 - System (1) > LAN1 - Network Topology
tab. The Listen Port was set to 5060 which is the port number supported by Vitelity.

e The Calls Route via Registrar was unchecked. In this certification testing, Vitelity did not
support the dynamic Registration on the SIP Trunk.

e Other parameters retain default values.

e Click OK to commit then press Ctrl + S to save.

7 SIP Line - Line 17* ek - <
fSlP LinéjélP QRIIVOIP VISIP Crgdenti;}s]SIP Adyancgqiﬁngineering{
‘ ITSP Proxy Address 192168.142.93 ‘
Network Configuration
Layer 4 Protocol |upp |  SendPort (5060
Use Network Topology Info lLAN 1 V‘ 20
Explicit DNS Server(s) 0 0 0 0 0 0 0 0
Calls Route via Registrar [~ J
Separate Registrar
[ oK \ ‘ Cancel ’ I Help
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A SIP URI entry must be created to match for each outgoing number that Avaya IP Office Server
Edition will route on this line. Select the SIP URI tab; click the Add button and the New Channel
area will appear at the bottom of the pane (not shown). To edit an existing entry, click an entry in the
list at the top, and click Edit... button. In the example screen below, a previously configured entry is
edited. For the compliance test, a single SIP URI entry was created that matched any DID number
assigned to an Avaya IP Office Server Edition user. The entry was created with the parameters
shown below:

e Set Local URI, Contact, Display Name, and PAI to Use Internal Data. This setting allows
calls on this line whose SIP URI matches the number set in the SIP tab of any User as shown
in Section 5.9.

e Set Registration to 0: <None> as Vitelity did not require registration.

e Associate this line with an outgoing line group in the Outgoing Group field. This line group
number will be used in defining outgoing call routes for this line. For the compliance test, a
new line group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK to submit the changes.

= SIP Line - Line 17 e -M X | v <|>

LSIP LingJTransporrtj" SIP URI |VoIP J_SIP Credential‘sllslp AdvancedIEngineering‘

Add..

Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls

Remove

Edit Channel

Via 10.10.97.42 IL‘
Local URL - Cancel |
Contact v

Display Name -

PAI - Internal Datal -

Registration lO: <None> v

Incoming Group 17

Outgoing Group 17

Max Calls per Channel 20
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. The G.711 ULAW 64K, and
G.729(a) 8K CS —ACELP codecs are selected. Avaya IP Office Server Edition supports
these codecs, which are sent to the Vitelity, in the Session Description Protocol (SDP) offer,
in that order.

e Check the Re-invite Supported box.

e Set Fax Transport Support to G.711 from the pull-down menu. Vitelity supports Fax G.711
pass-through mode.

Note: Fax T.38 is not supported because Avaya IP Office Server Edition R9.1.1.0 Build 10 is
a Linux based system.

e Set the DTMF Support to RFC2833/RFC4733 from the pull-down menu. This directs
Avaya IP Office Server Edition to send DTMF tones using RTP events messages as defined
in RFC2833.

e Default values may be used for all other parameters.

e Click OK to submit the changes.

7 SIP Line - Line 17 e - X[ v <>
ESIP Liné!TransporfiS[P URI} iSlP Credentials!SIP Advanced[Engineeringi
[¥] Re-invite Supported
[7] Codec Lockdown
Codec Selection |CU5t°m '” ["] Allow Direct Media Path
U”USEd 55'“}'5"7 L Force direct media with phones
G.711 ALAW 64K S5 | G.711 ULAW 64K
6722 64K | 6.729(a) 8K CS-ACELP B4 ¥BACKA el Supported
|| G.711 Fax ECAN
Fax Transport Support |G.711 v’
DTMEF Support |RFC2833/RFC4733 -
Media Security | Disabled -
( OK ’ [ Cancel ’ l Help
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5.7.3. Create SIP Line Manually for Incoming Calls

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line (not shown).

On the SIP Line tab in the Details Pane, configure the parameters as shown below:

Set ITSP Domain Name to the IP address of Avaya IP Office Server Edition LAN1 port.
Check the In Service and Check OOS boxes.

Set URI Type to SIP.

For Session Timers, set Refresh Method to Reinvite with Timer (seconds): 1200.

For Forwarding and Twinning, set Send Caller ID to None.

For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never.

Default values may be used for all other parameters.

e Click OK to commit then press Ctrl + S to save.

7 SIP Line - Line 18" ok -8 X | v | <
e — - — — — - :
SIP Line %TransportISIP URIl VoIP ISIP Credentials!SIP Advanced'Engineering‘
Line Number 18 S IIn Service f;/_?l
ITSP Domain Name 10109742 | Check 00S ﬂl
URI Type |sip «|| [ Session Timers
Location [Cloud 25 | Refresh Method Reinvite v
Timer (seconds) 1200 2
Prefix Forwarding and Twinning
National Prefix Originator number
International Prefix Send allesll lNone ']
Country Code Redirect and Transfer
Name Priority System Default - Incoming Supervised REFER INever v]
Description Outgoeing Supervised REFER [Never v]
Send 302 Moved Temporarily
Outgoing Blind REFER
) 0
l Cancel ‘ ‘ Help
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of Vitelity signaling server
192.168.142.90 as shown in Figure 1. This is the SIP Proxy address used for incoming SIP
calls.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060 which is the port number supported by Vitelity.

e The Use Network Topology Info parameter was set to LAN 1. This associates the SIP Line 18
with the parameters in the DevCon IPO Sev2 - System (1) > LAN1 - Network Topology
tab. The Listen Port was set to 5060 which is the port number supported by Vitelity.

e The Calls Route via Registrar was unchecked.

e Other parameters retain default values.

e Click OK to commit then press Ctrl + S to save.

i SIP Line - Line 18* &k - Zi = s

ESIP Lin;glP URIIVoIP VISIP Credentials]SIP AdvancedIEngineering\'

| ITSP Proxy Address | 192.168.142.90 ‘

Network Configuration

Layer 4 Protocol lUDP VJ Send Port 5060

Use Network Topology Info l LAN 1 v ‘ 5060
|

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar [ |

Separate Registrar

\ oK H Cancel H Help
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A SIP URI entry must be created to match each incoming number that Avaya IP Office Server
Edition will accept on this line. Select the SIP URI tab; click the Add button and the New Channel
area will appear at the bottom of the pane (not shown). To edit an existing entry, click an entry in the
list at the top, and click Edit... button. In the example screen below, a previously configured entry is
edited. For the compliance test, a single SIP URI entry was created that matched any DID number
assigned to an Avaya IP Office Server Edition user. The entry was created with the parameters
shown below:

e Set Local URI to * to accept any incoming calls. Set Contact, Display Name, and PAI to
Use Internal Data. This setting allows calls on this line whose SIP URI matches the number
set in the SIP tab of any User as shown in Section 5.9.

e Set Registration to 0: <None> as Vitelity did not require registration.

e Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming call routes for this line. For the compliance test, a
new line group 18 was defined that only contains this line (line 18).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK to submit the changes.

= SIP Line - Line 18 g X | v =

1:‘:1P LinelTransport‘i SIP URI ;WoIP ISlP CredentialsISIP AdvancedIEngineering‘1

Channel Groups Via Local URI Contact Display Name PAI Credential MaxCaIIs‘ Add...

Remove

Edit Channel

Via 10109742 M
Local URI 7 = | Cancel |
Contact v:
| Display Name Use Internal Data -
| P v
Registration IO: <None> A
Incoming Group 18
Outgoing Group 0
| Max Calls per Channel 20
|
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. The G.711 ULAW 64K, and
G.729(a) 8K CS —ACELP codecs are selected. Avaya IP Office Server Edition supports
these codecs, which are sent by the Vitelity.

e Check the Re-invite Supported box.

e Set Fax Transport Support to G.711 from the pull-down menu. Vitelity supports Fax G.711
pass-through mode.

Note: Fax T.38 is not supported because Avaya IP Office Server Edition R9.1.1.0 Build 10 is
a Linux based system.

e Set the DTMF Support to RFC2833/RFC4733 from the pull-down menu. This directs
Avaya IP Office Server Edition to send DTMF tones using RTP events messages as defined
in RFC2833.

e Default values may be used for all other parameters.

e Click OK to submit the changes.

7 SIP Line - Line 18* ok - | X[ v <
'SIP Line| Transport | siP URI 'SIP Credentials| SIP Advanced  Engineering|
[¥] Re-invite Supported
[7] Codec Lockdown
Codec Selection lCustom 'I || Allow Direct Media Path
H“Eﬁfv - ,Seil,eﬁedi,i— Force direct media with phones
G.711 ALAW 64K s> || [G711 ULAW 64K -
6.72264K | 6.729(a) 8K CS-ACELP (] PRACK/100rel Supported
G.711 Fax ECAN
Fax Transport Support |G.711 'l
DTMF Support |RFC2833/RFC4733 -
Media Security |Disabled v
[ OK | l Cancel ’ I Help
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5.8. Outgoing Call Routing

5.8.1. Short Code in Primary Server

Define a short code to route outbound traffic on the SIP line to Vitelity. To create a short code, select
Short Code in the left Navigation Pane, then right-click in the Group Pane and select New (Not
shown). On the Short Code tab in the Details Pane, configure the parameters for the new short code
to be created. The screen below shows the details of the previously administered “6N;” short code
used in the test configuration.

e In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 6N;, this short code will be invoked when the user dials 6 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.142.93”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the IP address of Vitelity
signaling server.

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.7.2. This short code will use this line group when placing the outbound
call.

e Setthe Locale to United States (US English).

e Default values may be used for all other parameters.

e Click OK to submit the changes.

-arcet Help
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office Server Edition. The Short Code FNEOO was configured
with following parameters:

e For Code field, enter FNE feature code as FNEOQO for dial tone.

e Set Feature to FNE Service.

e Set Telephone Number to 00.

e SetLine Group ID to 0.

e Setthe Locale to United States (US English).

e Default values may be used for other parameters.

e Click OK to submit the changes.

Shacons |E FNEOO: FNE Service® A
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5.8.2. Short Code and SIP Line in Expansion System

Define a short code to route outbound traffic on the SIP line to Vitelity. To create a short code, select
Short Code in the left Navigation Pane, then right-click in the Group Pane and select New (Not
shown). On the Short Code tab in the Details Pane, configure the parameters for the new short code
to be created. The screen below shows the details of the previously administered “66N;” short code
used in the test configuration.

e In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 66N;, this short code will be invoked when the user (using Avaya analog
or digital phones) dials 66 followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to 6N.

e Setthe Line Group ID to the 99999 defined on the Outgoing Group ID of the H.323 line
connecting the Expansion System to the Primary Server. This short code will use this line
group when placing the outbound call via Avaya IP Office Server Edition Primary Server.

e Set the Locale to United States (US English).

e Default values may be used for all other parameters.

e Click OK to submit the changes.
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Verify the ID of the H.323 line connecting the Expansion System to the Primary Server. To do this,
select Expansion Line on the navigation pane and select the H.323 line on the Group pane (line 17
on the screen below). Make note of the Outgoing Group ID 99999 on the Details pane. The
Address is Avaya IP Office Server Edition LAN1 IP Address 10.10.97.42.
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5.9. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.7. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 9042. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 9042. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by Vitelity. The SIP Display Name (Alias) parameter can
optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User 9042. The Mobility Features and Mobile Twinning boxes
are checked. The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 61613XXX5205. Check Mobile Call Control to allow
incoming calls from mobility extension to access FNEOO (see Section 5.8.1). Other options can be

set according to customer requirements.
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5.10. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (Not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the Incoming Group 18 defined on the SIP URI tab on the SIP
Line in Section 5.7.3.

e Set the Incoming Number to the incoming DID number on which this route should match.

e Default values can be used for all other fields.
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On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 303XXX9042 on line 18 are routed to extension 9042.
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For testing purpose, the incoming calls to DID number 303XXX9047 were configured to access
FNEOQO. The Destination was appropriately defined as FNEOO as below screenshot:
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For testing purpose, the incoming calls to DID number 303XXX9047 were also configured to access
VoiceMail. The Destination was appropriately defined as VVoiceMail as below screenshot:
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For Inbound Toll-Free testing purpose, any incoming calls to DID number 866 XXX3773 were also
configured to route to extension 9042. The Destination was appropriately defined as 9042 as below
screenshot:
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5.11. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Vitelity SIP Trunk Configuration
Vitelity is responsible for the configuration of Vitelity SIP Trunk Service. The customer must
provide the IP address used to reach the Avaya IP Office Server Edition at the enterprise. Vitelity
will provide the customer necessary information to configure the SIP connection between Avaya IP
Office Server Edition and Vitelity. The provided information from Vitelity includes:

e [P address and port number used for signaling or media through any security.

e DID numbers.

e Vitelity SIP Trunk Specification.
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office Server Edition System Status application to verify the state of the
SIP connection. Launch the application from Start = Programs = IP Office - System
Status on the PC where Avaya IP Office Server Edition Manager was installed. Select the
SIP line of interest from the left pane. On the Status tab in the right pane, verify that the
Current State for each channel (The below screen-shots showed 2 active calls at present

time).
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Use the Avaya IP Office Server Edition System Status application to verify that no alarms are active
on the SIP line. Launch the application from Start - Programs > IP Office > System Status on
the PC where Avaya IP Office Server Edition Manager was installed. Select Alarm = Trunks to
verify that no alarms are active on the SIP lines.

+f Avaya P Office Syitemn Sates - DevCon IR0 562 (101037 &2 - [P Office Lines FC 5110 budkd 10

=
IP Office System Status

Select 2 Ine to duplay the alarss information

[ 0, 10.97.99
" 5 0. 10.97.9

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
Server Edition with two-way audio.

e Verify that a phone connected to Avaya IP Office Server Edition can successfully place a call
to the PSTN with two-way audio.
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8. Conclusion

Vitelity passed compliance testing excepting the limitation in Section 2.2. These Application Notes
describe the procedures required to configure the SIP connection between Avaya IP Office Server
Edition and the Vitelity as shown in Figure 1.

9. Additional References

[1] IP Office 9.1 Administering Avaya IP Office Platform with Manager, Release 9.1, Issue 10.03,
February 2015.

[2] Avaya IP Office™ Platform Server Edition Reference Configuration Release 9.1, Issue 02.06,
April 2015.

[3] Deploying Avaya IP Office™ Platform Server Edition Solution Release 9.1, Issue 02.07, April
2015.

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XM LFILE=manuals.
XxmI&TEMPLATE=pdf feed_ template.html.

Product documentation for Vitelity SIP Trunking may be found at: http://www.vitelity.com
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Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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